Geopak Drainage Data to HydInfra

Overall Procedure:

Edit Geopak Drainage file (gdf) so represents as-built condition
Export node and link csv files from gdf files using drf file templates
Load MnCON if not already loaded on computer

Set-up Excel and Add-in files

Run add-In

Edit Data

Create HydInfra input file

Upload data to HydInfra

NG~ wWNE

1. Edit GDF file

A design GDF file may need editing before it is exported to a HydInfra input file. The design
GDF file may contain alternatives that were not incorporated into the design, temporary
drainage features, features that belong to a local agency, and/or existing features that already
exist in HydInfra.

2. Export Node and Link csv files from Geopak Drainage

1. Load MicroStation and edited Geopak Drainage design files from Projectwise

2. Select from Drainage menu: Reports > Generate

3. Select the Drainage Report file for nodes: Hydinfra_Node.drf in Projectwise from:

CADDStandards > MnDOT Standards > DOT-Geopak > dlb > Reports

4. For the output file, navigate to your project folder in ProjectWise and name the file,

include “Node” in the file name and set the extension to .csv

Select Generate to create the node data file

6. Run again using the HydInfra_Link.drf Drainage Report file and name the output file
to include “Link”

7. Export the Node and Link csv files to a project directory on the network, or the
c:\hyihelp\spreadsheets directory (created in section 4 below)

o

3. Load MnCON 2.5.1 or older (if not already loaded)

The current version of MNCON (3.0.1) from Land Management does not work with excel
spreadsheet. If you already have MnCON loaded, check that the version is from prior to 2010
(2.5.1 or prior). See the Help > About in MNnCON or the history.txt file in C:\Program
FilessMnCON to determine which version you have.

Version 2.5.1 of MnCON is available on the external HydInfra webpage — under Data

Formatting > Alternative Published Format as the Coordinate Projection Application.
http://www.dot.state.mn.us/bridge/hydraulics/hydraulics/hydinfra/dataformatting/geopakalternatedata.html

If you need to load MnCON, you will need administrative privileges on the computer. If you
have a more recent version of MnCON loaded, you will need to uninstall, and then install

Page 1 of 11


http://www.dot.state.mn.us/bridge/hydraulics/hydraulics/hydinfra/dataformatting/geopakalternatedata.html

version 2.5.1. Once you are done with formatting the HydlInfra data, you should uninstall
version 2.5.1 and install the most current version from MnDOT Land Management.

4. Set-up Excel and Add-In Files

Set up Directory Structure (if not already set-up)

e Create C:\HYITEMP
e Create C:\HYIHELP
e Create C:\\HYIHELP\Spreadsheets

Check Excel Security
On the Developer tab, in the Code group, click Macro Security.

ilin]
Tip  If the Developer tab is not displayed, click the Microsoft Office Button “* , click
Excel Options, and then in the Popular category, under Top options for working with
Excel, click Show Developer tab in the Ribbon.

In the Macro Settings category, under Macro Settings, click either Enable all macros or
Disable all macros with notification. (If select disable all macros with notification, then be
sure to Enable the Macro when you open the spreadsheet).

Get Excel and Add-in File

1. Navigate in ProjectWise to CADDStandards > MnDOT Standards > DOT-Geopak >

dlb > Reports

Select GP2HY .xla and hyd_csv.xls and export. Save an unmanaged copy in

c:\hyihelp\spreadsheets

Open hyd_csv.xls from d:\hyihelp\spreadsheets

Click on Office Button and select Excel Options

Select Add-Ins

Near the bottom of the dialog — for Manage, select Excel Add-Ins and then click on

Go button

7. Browse to c:\hyihelp\spreadsheets and select GP2HY I.xla, make sure it is toggled on
in the list and select OK. You should get a message that a new menu item has been
added.

no

o0k w
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5. Run Add-In

In hyd_csv.xls, select Add-Ins tab
Click on GeoPak Conversion button.

GeoPak to HYDINFRA Conversion Utility

The GeoPak to HYDINFRA Conversion Utility form appears.

GeoPak to HYDINFRA Conversion Utility

SelectNodeFile | |

SelectLinkFile | |

Select County Coordinate |

Owner |

Maintenance Responsibility |

Lol Lefle]

Data Input By : [Name}|

SP Mumber |

Activity Date [MI/DDAYYY | 07/02/2006

Date Built [MW/DDAYYY] |

M3 4 [YirMULL] -

Roadway Type & Roadway Traffic
Direction are entered separately by Chain

Process Files |

Exit |
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GeoPak to HYDINFRA Conversion Utility Form and Required Fields

Fill in all known data. There

Select County Coordi

default.

are four required fields on this form:

nate — Select a county

Select Node File — Navigate and select a Node File created in Section 2
Select Link File — Navigate and select a Link File created in Section 2

Activity Date [MM/DD/YYYY] -- Today’s date is automatically entered as a

e The Date Built is not required, but is highly recommended to enter 12/31/xxxx
where xxxx is the year the project was completed.

GeoPak to HYDINFRA Conversion Utility [g|

Select Mode File

| Ci\tempGP2HYTGPData \ModesM, cay

Select Link File

| C:\temp'GP2HYI\GPData \PipesM. csv

Data Input By :
SP I

Select County Coordinate | Anoka

Maintenance Responsibility | Metro

Activity Date [MM/DDAYYY] | 07/02/2006
Date Built [MM/DDAYYY] | 07/02/2006

M5 4 [YMMULLL | -

Roadway Type & Roadway Traffic Process Files
Direction are entered separately by Chain

Owner | Metro

Ll L Lo

[N3m9}| test user

umber | 133455

Exit

Next, select the “Process Fil

es” button or “Exit” button.
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Chain Based Attributes Form and Required Fields

Each GeoPak Chain has a Roadway Type, which is a required field in HYDINFRA.
The user must associate a Roadway Type to each chain. Traffic Direction is not a
required field.

Step 1 — Select a Chain

Select a chain. In this example, a chain called, “INP64NB” was selected.

Chain Based Attributes

INPE3ME Selected Chain: Mone
COMMDRM

?ﬁ Roadway Type (Required) | Entrance j
40THBL o
WINDSORC Traffic Direction
11TH
40THWE
40THEB Please Select a Chain 4
WILLOWHTS and enter the . |
gﬁk:—%ﬁmm appropriate data. Click S

-| Addto add the data to |
LOGRF = each Chain Done

Step 2 — Select a Roadway Type

Click on the “Roadway Type” Pull-down. In this example, “Entrance” was selected.

Step 3 — Select a Traffic Direction

This is not a required field. Enter a value if known.

Step 4 — Click on the “Add to Chain Data” button

The Roadway Type and Traffic Direction data are appended to the Chain. See
screen print on next page.
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The Roadway Type and Traffic Direction have been appended to the Chain.

[Ch ain Based Attributes

4| ‘Felected Chain: INFE3IMNB Entrance MB
| COMMDRM

15TH Roadway Type (Required) | j
40THBL
WINDSORC Traffic Direction | j
11TH
40THWE
40THEB Please Select a Chain
WILLOWHTS and enter the :
E‘:HI%""RDG appropriate data. Click e i

- Add to add the data to
LOOPF =l each Chain Done

Step 5 — Repeat process for all chains

Every chain must have a Roadway Type associated with the record because it is a
required field in the HYDINFRA database.

Step 6 — Click on the “Done” button

GeoPak to HYDINFRA Conversion Utility Processing
Options

Edit Output File

If the user would like to edit the output files, click the “Yes” button.

\..v Do You Want to edit the Qutput File?

Yes Mo |
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The program will count and provide a total of each record type to the user.

X

236 Pipes 217 Strucs 72 5Ps

Microsoft Excel

Click “OK” to continue.

E3 Microsoft Excel - hyd_csv.xls

CEX

iE] Fle Edit View Insert Format Tools Data  Window Help GeoPak Conversion Type & question forhelp =/ & X
=R ERE AR N - HG -0 -|[B]lzr U E= =45 % “
Al - # Field

A B | C [ D [ E [ F [ G =
1 |Field Required 3
2 |[1] Record Number Yes 290 291 292 293 "294 E
3 |[2] Record Type Yes TPF_Pipe “TPF_Pipe TPF_Pipe TPF_Pipe TPF_Pipe
4 [[3] Longitude Yes "924817.0128 924946 4057 9249461957 "924946.1927 924945 6624
5 |[4] Latitude Yes "451020.0876  450958.3108 4509578172 "450955.7242 "450955.7246
6 [[5] UTM X Yes 515344 41 513394 61 ’613399.23 613399 43 "513411.01
7 |[6] UTM Y Yes 500210364 V5001427 23 500141201 5001347 42 5001347 45
8 |[7] Lat/Long Coordinate Method Yes Plan Sheet “Plan Sheet Plan Sheet Plan Sheet Plan Sheet
9 [[8] UTM Coordinate Methad Mo Plan Sheet “Plan Sheet Plan Sheet Plan Sheet Plan Sheet
10 [[9] Location Accuracy Yes < (.5 meter Y.< 0.5 meter = (.5 meter = (.5 meter = (.5 meter
11 [[10] Status Yes Proposed " Proposed Proposed Proposed Proposed
12 |[11] Flowline Elevation Mo "050.486 "1232.470 M230.946 220034 M219.578 v
1w + » w}\TPF_Pipe, TPF_Struc / TPF_SpStruc £ TPF_SPCD £ Lists / Instructions { Sheeti / (< N
Ready NUM

The data is loaded into the spreadsheet and placed into the appropriate Record Type
worksheet tabs. The user can edit data in any four record types.

6. Edit Output Data

Recommended items to edit:
Special Structure — look for safety apron or grates in plan and edit appropriate record

Pipes — put in comments for anything unusual, if Design 3006, put in comment, add design
flow frequency if known.

7. Create HydInfra Input File

Process Output File
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After the user is finished editing data in the four Record Types in the spreadsheet,
the data must be transformed into a cvs format that is ready for HYDINFRA. This
process must be performed on each of the four Record Types.

Step 1 — Click on Column “C” and highlight the entire column

B3 Microsoft Excel - hyd_csv.xls r;”E'E'
E‘_’] Eile Edit View Insert Format Tools Data  Window Help GeoPak Conversion

iNESHISRAI ST 2 e e -0 -|BZU|E=S=5]S %

C1 - e
A | B D | E | F | G =

1 |Field Require

2 |[1] Record Number Yes 290 291 292 293 204

3 |[2] Record Type Yes TFF_Pipe TFF_Pipe TPF_Pipe TPF_Pipe TPF_Pipe

4 |[3] Longitude Yes 9246170128 924946.4057 524946 1957 524946 1927 524945 6624

5 |[4] Latitude Yes 451020.0876 450958.3108 450957 8172 450955 7242 "450955 7246

6 |[5] UTM X Yes 515344 .41 513394.61 513399 23 513399 43 "513411.01

7 |[6] UTM Y Yes 5002103.64 5001427 23 "5001412.01 5001347 42 5001347 45

8 |[7] Lat/Long Coordinate Method Yes Plan Sheet Plan Sheet Plan Sheet Plan Sheet Plan Sheet

9 |[8] UTM Coordinate Method No Plan Sheet Plan Sheet Plan Sheet Plan Sheet Plan Sheet

10 |[9] Lecation Accuracy Yes < 0.5 meter < 0.5 meter < 0.5 meter < 0.5 meter < 0.5 meter

11 |[10] Status Yes Proposed Proposed Proposed Proposed Proposed

12 |[11] Flowline Elevation No 1050.486 1232470 1230 946 220 034 "219578 v
4 4 » M} TPF_Pipe, TPF_Struc f TPF_SpStruc £ TPF_SPCD £ Lists / Instructions f Sheetl / < >
Ready NUM

Step 2 — Continue to highlight all columns by holding shift key and pressing right
arrow button until the end. In the example below, we had to scroll 236 columns to
Column “ID”.

B3 Microsoft Excel - hyd_csv.xls

I‘:‘I_] Eile Edit Wew Insert Format Tools Data Window Help GeoPak Conversion x

inGEH @Al ALE e [l -0 -|B 7 U S== ?
C1 - r:

B v |z [ A [ B | _c__| D NN

i

| 2 [520 621 522 523 624 525

| 3 [TPF_Pipe TPF_Pipe TPF_Pipe TPF_Pipe TPF_Pipe TPF_Pipe

| 4 [924816.5425 924938 1228 924818 4719 924512 899 "§24813 6067 924511 4914

| 5 [451018.8436 450954 1636 451013 8184 451024 5696 451011 2842 451037 7908

| 6 [515354.77 5135757 '515313.03 51543387 51541942 '515463.6

| 7 [5002065 28 5001299 64 500191011 5002242 17 5001832 16 5002650 23

| 8 |Plan Sheet Plan Sheet Plan Sheet Plan Sheet Plan Sheet Plan Sheet

| 9 |Plan Sheet Plan Sheet Plan Sheet Plan Sheet Plan Sheet Plan Sheet

| 10 |= 0.5 meter < 0.5 meter < 0.5 meter < 0.5 meter < 0.5 meter = 0.5 meter

| 11 |Proposed Proposed Proposed Proposed Proposed Proposed

| 12[1054.040 "1204.700 "1050.320 "1044.970 "1047.010 1042230 v

4 4 » w\TPF_Pipe{ TPF Struc / TPF_SpStruc £ TPF_SPCD / Lists / Instructions / Sheetl / | TN

Ready MM
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Step 3 — On the P759 Record Navigator, click the “Copy Selected Columns To
Sheetl” button.

iE] Fle Edt Wew Insert Format Tools Data  Window

C1

Ready

4« » W)\TPF_Pipe TPF_Struc £ TPF_SpStruc { TPF SPCD / Lists { Instructions £ Sheet1 /.

Help GeoPak Conversion P759 Record Navigator El
_jljlg|ﬂ_l|u‘|z'%l|'@ Ei.ﬂrial 'm 'l:BIH|§§EE|$..l= PF_ExPondInsp :j
A TPF_SPCDandInsp
TPF_SPCD
PF_ExSPCDAct
PF_ExSPCDInsp
521 522 523 524 525 TPF_Ditchandlnsp
: . - - : TPF_Ditch
;I'F*F_P|pe ;I'F’F_the TPF_Pipe 'TPF_P|pe ;I'F*F_P|pe PF_ExDitchact
924938.1228 0248184719 '924312.399 924813 6067 924811.4914 | PF_ExDitchinsp
"450954.1636 451013.8184 451024 5696 451011.2842 4510377908 | TPF_Enviran
513575.7 515313.03 515433 87 516419 42 5164636 b e
5001299 64 "5001910.11 5002242 17 5001832 16 5002650 23 TPF _Tlicit
Plan Sheet Plan Sheet Plan Sheet Plan Sheet Plan Sheet Lsts
Plan Sheet Plan Sheet Plan Sheet Plan Sheet Plan Sheet i 5
< 0.5 meter < (1.5 meter < (.5 meter < 0.5 meter < 0.5 meter
Proposed Proposed Proposed Proposed Proposed
"1204.700 "1050.320 "1044.970 "1047.010 "042.230 Copy Seected s To Shett |

Create CSV File |

Step 4 — Perform steps 1 - 3 for the other three Record Types.

Step 5 — Select Sheetl and validate that the data has been transformed and placed
into Sheet 1.

Microsoft Excel - hyd_csv.xls

E_'] File Edit Vew Insert Format Tools Data  Window GeoPakCon\rersion

N EEH a2z e @i -0 -|B 7 U|

H233 = =
I A |8 [Te [ [FE [ F I 6 s 1 [ 9 [k [ [ M
1224513 TPF_Pipe 824810.82151039.10'515478.02/5002690.8 Plan Shee Plan Shee < 0.5 mete Proposed 1045620 Fest Plan Sh
1225614 TPF_Pipe [924809.1751040.33/515513.96'5002728.8 Plan Shee Plan Shee < 0.5 mete Proposed [1065.541 |Fest Plan Sh
1226515 TPF_Pipe 824808.947151040 86515518 965002745 2 Plan Shee Plan Shee < 0.5 mete Proposed 1064 414 Feet Plan Sh
227'515 TPF_Pipe 824820 6651020 83515264 545002126 6 Plan Shee Plan Shee < 0.5 mete Proposed (1056 640 Fest Plan Sh
1228517 TPF_Pipe 824817 4051020 28515335.91/5002109.6 Plan Shee Plan Shee < 0.5 mete Proposed 1050 930 Fest Plan Sh
229518 TPF_Pipe 9245817 4651020 74515334 53'5002123.9 Plan Shee Plan Shee < 0.5 mete Proposed 1051.830 Feet Plan Sh
230[519 TPF_Pipe 24817 28"51019.97/515338.44/5002100.0 Plan Shee Plan Shee < 0.5 mete Proposed 1055280 | Feet Plan Sh
231 520 TPF_Pipe 924816 54451018 .84/515354 77/5002065.2 Plan Shee Plan Shee < 0.5 mete Proposed 1054 040 | Feet Plan Sh
1232521 TPF_Pipe 924935.12"450954 16513575.7 '5001299.6 Plan Shee Plan Shee < 0.5 mete Proposed 1204.700 Feet Plan Sh
1233522 TPF_Pipe 824818.47151013.81/515313.03/5001910.1 Plan Shee Plan Shee < 0.5 mete Proposed [1050.320 | Fest Plan Sh
1234523 TPF_Pipe 824812.89151024.56'515433.87/5002242.1 Plan Shee Plan Shee < 0.5 mete Proposed 1044.970 Feset Plan Sh
235(624  TPF_Pipe (24813 60451011 28515419 425001832 1 Plan Shee Plan Shee < 0.5 meteProposed "1047.010 |Fest Plan Sh «
Il « » W} TPF_Pipe { TPF Struc £ TPF SpStruc / TPF_SPCD / Lists / Instructions % Sheetl / | m) >
Ready UM
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Step 6 — Create CSV File

E3 | Micrasoft Excel - hyd_csv.xls -

Gle Edt Vi I Format  Tools Data Window Help GeoPak Conversion P759 Record Navigator E] =S
J ﬁ Ig ‘d ";‘lﬁ |5 - ‘,‘ - |\% E T Al | '@ ! Anal le ..v.l.‘B ‘( E | el 3 TPF_PipeandInsp -
Gl = i © ;EFEP:EE Act
A ) 7 L ) S | e [ SR W] b pipeinspOny i
EN@ TPF_Pipe 954338 12"470517 75/293006.02'5218582 1 Plan Shee Plan Shee < 0.5 meteProposed 1469447 [Feet | PF_ExPipeancinso =
L‘H TPF_Pipe "954340.43770517.75/292957 28/5216563.7 Plan Shee Plan Shee < 0.5 mete Proposed 146_8.632 Feet gi-ggﬂ?"dmsp
13 12 TPF_Pipe 954340 437470517 177292956 7 52185661 Plan Shee Plan Shee < 0.5 mete Proposed 1468.219 Feet W or Eosvicacs
| 4 N3 TPF_Pipe 954344 91 47051? 82292862 915218589 3 Plan Shee Plan Shee < 0.5 mete Proposed 1468.029 Feet | PF_ExStrucinspOnly
| 5 N4 TPF_Pipe 954347 40470518 10292810 8 5218599 & Plan Shee Plan Shee < 0.5 meteProposed 114661  Feet | PF_ExStucandinsp
[ 6 115 TPF_Pipe /954347 517470517 81'292506.08'5218591.0 Plan Shee Plan Shee < 0.5 melcProposed 14659 Feet | qorsrepoe o ™
7 [16 TPF_Pipe 954344 91"470517.17292862.26/5218569.1 Plan Shee Plan Shee < 0.5 mete Proposed 1466.535 Feet | PF_ExspStrucAct
8 [17 TPF_Pipe 954347 417470517 10292609 495218569 0 Plan Shee Plan Shee < 0.5 mate Proposed 114653 Feet PF_ExSpStruclnspOrly
Elg TPF_Struc’854347.51'470617.81292508.08/5218591.0 Plan Shae:Plan Shee < 0.5 meteProposed 1465.9  Feet | F-FxsSpSirucandins el
(103 TPF_Struc'95434T_41-'470517.10'292809.49 "5218569.0 Plan Shee Plan Shee < 0.5 meteProposed 1465.3  Fest - i
115 TPF_Struc’954344 917470517 177292862 265218569 1 Plan Shee Plan Shee < 0.5 mete Proposed 1466 535 Feet | [ |
1216 TPF_Struc954340.43 47051? 757292957 285218583 7 Plan Shee'Plan Shee < 0.5 mate Proposed '1458 632 Fefl [ 1
113 [7 TPF_Struc/854338.12"470517 752930060252 18582 1 Plan Shee'Plan Shee < 0.5 meteProposed [1469.447 |Fedt Create CSV File | 2
EVi - _TDE _=tpusaEd 244 0177017 2207269 01218520 2 Dian Shao Dlan @hos o 1A mate Deanacad T14G2 01790 Enf :
4 4 » M\ TPF_Ppe £ TPF_Struc £ TPF_SpStruc £ TPF_SPCD / Lists / Instructions  Sheet1 / < |
Ready N&M

On the P759 Record Navigator, Select the “Create CSV File” button.

Save in v|@*@|ﬁ>‘f 4 [EH ~ Tools -
@ E]Testthses
My Recent %}Nodes.csv
LIEETE B nodeTest.csv
= %']Pipes.csv
I_. @Pipesm.csv
Desktop @pipeTest.csu
My Documents
My Computer
-
hi- ! File name: |hyi.n:sv V| [ Save
My Metwaork =
Places Save as tyPel | TextFiles (%.csv) v| L_cancl

Save the file.
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8. Load Input File

e Go to the HydInfra web site

e Enter the user name and password

e Select MnDOT as the company name, select your district as the work location and
enter your email address

e Browse to the input file that you created, then Submit.

Contact Lisa Sayler via email at lisa.sayler@state.mn.us or at 651-366-4468 with any
questions.
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